IR Release 4.02 Notes

Bug Fixes:

USB interface wasn’t working for remotes with EEPROMs smaller than 2K.  This has been repaired.

New Features:

IR can now load the I/O port driver (gwiopm.sys) from the Windows or Windows\System directory.  This allows users to run IR from any drive (not just the boot drive) as long as they copy gwiopm.sys to one of these places.

Several new DigitMap entries have been added.

IR Release 4.01 Notes

New Features:

A “Set RDF Path” option has been added to the File menu to allow users to specify where the RDF files are stored.  This will allow users to more easily share RDFs across applications, and will help to keep the IR directory less cluttered.

IR Release 4.00 Notes

New Features:

Support has been added for two new interfaces.  IR now supports a serial interface and a USB interface (using the Delcom USB chip) in addition to the parallel interface.

The Interface | Transmission Delay menu item has been moved to the Advanced menu.

A “Configure Interface” option has been added to the Advanced menu for both the parallel and the serial interfaces.  This allows interface hardware designers to indicate which ports/offsets/pins a new interface is connected to.  To access these menu options, a value named “SpecialHardware” must be added to the registry under HKEY_CURRENT_USER\Software\UEIC.  The type and value of this entry doesn’t matter.  (Note:  Manually modifying the registry is not recommended for normal users.  This option is only intended for experts.)

Read-verification has been made optional.  In prior versions, IR always read back the contents of the EEPROM after writing to it in order to verify that the write successful.  This re-reading is probably overkill since problems encountered while writing should be identified as they occur, so users can now go to the Interface menu to disable the read-after-write verification.

IR now allows buttons to be restricted within the RDF.  For each button, the RDF developer can now indicate where the button can be used and where it can’t.  For example, a device button (such as VCR) can be defined so a user can’t bind a macro to it, but it can be used within a macro.  These button restrictions should allow all of the P8-style remotes to be defined correctly with respect to their Shift and XShift capabilities as well.
The user can now specify both Shifted and XShifted keys.  The names used by IR to label the “Shift” and “XShift” states can now be specified in the RDF.  This will hopefully help to reduce confusion for remotes that contain an actual Shift key.

Support has been added for the URC-6131, and any other remote that stores KeyMoves in EFC format rather than as Hex Commands.  (In this format, single-byte entries are interpreted as KeyCodes and two-byte entries are interpreted as 16-bit EFCs.  Longer entries are preserved as is, but are interpreted as KeyCodes.)

An optional Identification value is now available for RDFs.  If specified, then this will be displayed for each matching RDF when multiple RDFs match a given signature.  The identification string should provide the information needed by the user to allow him/her to determine which RDF is appropriate to the given remote.
RDFs now recognize quoted strings, so key names can contain spaces.

Boolean values in RDFs can now be set to Y, N, Yes, No, T, F, True, False, 1, or 0.

IR Release 3.20 Notes

Bug Fixes:

Various minor bugs have been fixed.  Unfortunately, version control went down so I don’t have a good list.

New Features:

The DecodeIR DLL has been integrated into IR to allow for better analysis of learned signals.

Several RDFs have been added to the distribution zip.

Several entries have been added to the digit map tables to support additional remotes.

IR Release 3.12 Notes

Bug Fixes:

Repaired a problem that caused a Privileged Instruction error when changing the port address on NT-based systems.

IR Release 3.11 Notes

Bug Fixes:

Import of key moves from KM had been discarding the first key move if the device the key was bound to had not yet been defined.

Registry key for ExeFile entry has been changed to HKEY_CURRENT_USER\Software\VB and VBA Program Settings\Keymap-Master\IR.

New Features:

Several RDFs have been added to the distribution zip.

Several digit map entries have been added.

IR Release 3.10 Notes

Bug Fixes:

Modified the handling of “empty” signatures to allow uploads/downloads to complete when the signature is all $00s.  (Previous versions assumed that an empty signature was necessarily an indication of a bad interface and did not allow the operation to continue.)

A “List Index” error (which occurred when a bad EEPROM image was loaded) has been fixed.  IR will now issue a warning.

Several minor problems have been fixed in the protocol disassembler.

New Features:

IR now supports remotes with EEPROMs larger than 2K bytes.

The EEPROM size is now auto-detected.  A warning message will be displayed if the detected size differs from the size listed in the RDF.

The list of RDFs displayed in the Select Remote dialog is now displayed in sorted order, either by signature or description.

If multiple RDFs match the remote’s signature, IR tries to automatically select the correct one.

Key moves and macros can now be “imported.”  This allows device upgrades to be fully defined within (an upgraded) KM, even if the keys that you want to assign functions to are not mapped for the current device. 

IR now writes the full file name (including path) of the program to HKEY_CURRENT_USER\Software\VB and VBA Program Settings (in the registry) each time it is started.

IR Release 3.07 Notes

Bug Fixes:

The items in the Learned Tab’s scroll box should now be positioned correctly regardless of the position of the scroll bar.

New Features:

IR now has the capability of setting the clock when uploading to certain P8-style remotes.  (Downloading will still reset the clock to 12:00AM.)  This functionality must be supported in the remote’s RDF.

The home theater settings on certain P8-style remotes can now be stored in the EEPROM.  (Again, this functionality is dependent on RDF support.)  This means that HT settings programmed via IR will be persistent.  One limitation is that IR cannot read the HT settings from the remote, so any changes you make directly to the remote (without using IR) will be lost if the remote is reset.

When using the updated RDF in conjunction with an existing dump, you will get a message that the checksum is incorrect in the $700 region.  This message will be followed by a dialog informing you that some fixed data is incorrect.  Both of these messages are normal.  Simply tell IR to replace the existing data with the fixed data and then fill in your home theater settings on the General tab.

Note that in order to achieve the new functionality, the size of the timed macro section has decreased slightly.  It’s possible that you’ll get an error if you have too many timed macros defined.

Badly learned signals are now broken down into two categories.  The first category is for signals that we don’t currently know how to decode, and the second is for signals that contain a portion that fires only when the button is released.  Signals that we can’t decode are often learned properly, but IR doesn’t yet know how to deal with them.  Signals of the other type are most likely learned badly and need to be relearned.

IR will now check to make sure that the EEPROM size is set correctly (in the RDF) every time it downloads from the remote.  It will issue a warning message if it encounters a conflict.

IR Release 3.06 Notes

Bug Fixes:

The device-specific upgrade section was not properly being loaded.  Only the first upgrade in the section was being loaded, so any subsequent save would wipe out all but the first one.  This has been fixed so you can now store (and load) multiple device-specific upgrades.

An access violation was occurring sporadically when the mouse cursor moved over a combo box’s open drop-down list. 

The forms have been shifted around slightly so data is no longer cut off when using large fonts.

New Features:

A “Purge Memory” feature has been added to the Advanced menu which sets all bytes in the buffer to $FF.  This can be used as an aid to create pristine dumps, but should only be used by people who know what they’re doing.

IR Release 3.05 Notes

Bug Fixes:

A few timing problems have been corrected in the interface check and the upload/download routines.

New Features:

Multiple instances of IR can now be running at the same time.

IR now supports the ability to store multiple macros on a single button (for remotes which support that functionality).

IR Release 3.00 Notes

Bug Fixes:

Burst timings in the "learned" tab were sometimes being displayed as double their actual length.

A few machine instructions were being disassembled improperly.

New Features:

Brand new interface routines -- All code that talks to the remote has been rewritten.  It should be more stable, less likely to provide false errors, and more helpful when it encounters an error.  Also, explicitly invoking the interface check is no longer required because it is built into the upload/download routines. (Thanks to Tommy for all his help!)

Modified the way IR deals with bit-mapped settings such as volume punch thru, sleep status, etc.  All of these settings can now be supported through generically through the RDF, which means that IR can now support all of the different implementations of VPT (including those that define VPT in multiple bytes).  It can also support less common features such as foreign language selection, etc.  And as more of these settings are discovered, they will be able to be supported with a simple addition to the RDF rather than requiring an upgrade to IR.

Supports "device-specific" upgrades for P8-style remotes.  (This is the memory area from $500..$6FF.)  This is especially useful in conjunction with older P8 models which have a bug that prevents normal upgrades (in the $100 section) from working.

Supports "timed macros" for P8-style remotes.  (This is the memory area from $700..$7FD.)

Supports Fav/Scan function of the 15-1995 remote, and most likely any P8-style remote with a Fav/Scan button.  (The RDF will need to be updated for other P8 remotes, as I don't know which ones they are.)

Supports OEM device types for remotes (such as the Replay and the Outlaw) that contain this sort of device type.

Prompts you to save the buffer before any operation that will cause unsaved changes to be lost.

A "Revert to Saved" option (which throws away changes) has been added to the File menu.

The data in the Raw tab now displays data that has changed in bold.  Also, the "Baseline" checkbox has been converted into a radio button that allows you to switch between viewing the data in the buffer, the data in the baseline, and the unmodified data.

The application’s size and state is now preserved across sessions.  This should be helpful for people running either very low or very high resolution.

Changed some terminology: Advanced codes are now known as Key Moves, etc.

A "clone" feature has been added for key moves, macros, and timed macros, which allows the user to add a new item based on an existing one.

Added a "device grid" to the Key Move add/edit dialog that displays all device type/code combinations that have been used, allowing you to more easily specify devices that have already been specified elsewhere.  This dialog is also resizable, and its height will be preserved across sessions.

Added a Summary option to the main menu that displays a textual summary of all the settings in the remote.  (Also added buttons next to each display grid that copy the contents of the grid into the clipboard.)

Added code to set ECP ports to operate in SPP mode.  Also added code to set the port to output mode, if for some reason it had been set to input mode.  This should theoretically remove the need for people to play with their port settings in Windows and/or the BIOS.

Error messages have been updated to (hopefully) be more informative.

Added a number of RDFs, and updated several others.  (Thanks Rob!)

Supports multiple RDFs for remotes whose out-of-the-box signatures may not be distinct.  In this case a dialog box will prompt you to select the RDF file appropriate to your remote.  This will likely become annoying pretty fast, so it is assumed that users who own one of these remotes will rename the RDF that isn't applicable to their remote, and/or potentially write a new signature to their remote to make it unique.

Added a "Clean Memory" function (available on the Tools menu) that sets all unused bytes from $100 and above to $FF.  This will not effect the data from the currently loaded dump.  (This was added to aid in manual analysis of these sections, and is not expected to be of much value to the typical user.)

Added a check when adding/editing key moves to make sure that a device/key combination only has one key move assigned to it.  Similarly, added a check when adding/editing macros to make sure that a key has only one macro assigned to it.

The meaning of AutoCheck has changed.  There is no longer a need to check the interface with the remote unplugged, so the interface check is now done (transparently) before every read/write operation.  In extremely rare circumstances (with "marginal" remotes, interfaces, and/or parallel ports) the interface test fails but the interface will still work.  The AutoCheck menu item allows users with this problem to disable the automatic test.  Note that regadless of the AutoCheck setting in previous versions, AutoCheck with default to "On" the first time you run 3.0.

The behavior has changed when the user enters an edit region by clicking on it.  Previously the region defaulted to unselected, but now it defaults to selected.  (This is consistent with what happens when the user tabs into an edit region.)

Added a space at the end of each line of data in the Device and Protocol edit dialogs.  This is helpful for those people who want to cut and paste existing protocols and manipulate them.

Users can now paste upgrade devices and/or protocols into the device and protocol edit boxes, even if they have commas embedded in them.  This is helpful for users who want use the new CSV files created when you hit SAVE in keymap-master

The look-and-feel of the user interface has changed in certain places to support the new functionality.

